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1. Package contents

Check your package for the following

items:

VNADD.
MILKING VACUUM DIAGNOSTICS

User manual

USB cable

Nouog,rwdbE

.....

ziBinControl

VaDia with rechargeable battery

Plastic hose 2x2.8 mm, hard
Silicon hose 2mm, soft
Application tool

User manual

Software-CD

. . H L]
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2. Hardware overview
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Vacuum sensors
USB connector
Indicator LED
Rechargeable battery
Battery cover
Overheating sensor
Battery type selector

NogakrwbdbE

. . H (]
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3. Firsttime setup
Before using your device, please follow the next steps.

3.1. Install the software for the instrument, VaDia Manager
The VaDia Manager installation program is found on the CD. Start the program
“Install VaDia Manager”, and the program will be installed on your computer.

File Edit Miew Favorites Tools Help
QBack > T | ' Search | Folders | m'

Address deh Fih

Falders x | Mame = | Size | Type

(B} Desktop | ) Cvivers File Falder

Q My Documents ..:,Install \-'aD!a Manager 1.04.exe 1907 KB npplfcatfon
g Install YaDia Program Loader 1.03.exe 15867 KE  Application

= j My Computer
%@ Local Disk {C:

3.2. Power up
Remove the plastic tab between the battery plus pole and the battery
compartment and make sure that the battery is properly inserted. The VaDia
startup sequence is:

- Theindicator LED will flash red 5 times

- Then the indicator LED will flash green 7 times

- There will be a pause of 15 seconds without any light

- After this, there will be 4 green flashes every 15 second
If the indicator LED flashes red 5 times and then starts flashing red over and over
again, then the battery voltage is too low and must be charged. The battery is
charged from a PC trough the USB cable. Plug the USB cable into both the VaDia
and a PC to start the charging. In five hours the battery is fully charged.

3.3. Install the USB drivers manually (NB! For advanced users only)
As the drivers will be installed automatically when installing the VaDia Manager,
this way of installing drivers can normally be ignored.

- Connect the VaDia and a PC using the USB
1) Found Mew Hardware E cable

BinControl - YaDia

As soon as the USB has been connected, the

c c : « M= | installation of the first driver will begin (there
= I[} | _I ' = are wo drivers)
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Found New Hardware Wizard

.

Welcome to the Found New

Hardware Wizard

Windows wil search for curert and updated software by
laoking on your computer, on e hardware instalation CD, of on
the Windows Lipdate ‘teb site [vith your permission)

Fiead ou privacy policy

Can'Windows cannect to Windows Update to ssarch for
software?

& s ihis tme orii
€ *es, now and gvery time | connect a device
€ Mo, nak this lime:

Click Nest ta confinue.

< Back Cancel

[Found New Hardware wizard

This wizard helps you install saftware for.

BieCorntrol - VaDia

) 1f your hardware came with an installation CD
<& or floppy disk. insert it now.

Whiat do you wark the wizard to do?

& instal e software automaticall [Fecommendsd)
© Install rom a st or gpecifc location (Advanced)

Click Mext to continue.

< Back I Nest > I

Concel |

Found New Hardware Wizard

Please wait while the wizard searches.

@ EioControl - VaDia

T

Please wait while the wizard installs the software...

Found New Hardware Wizard

3 BioControl - BC Serial Converter 2010

< Back Hert> Cancel

April 2011 VaDia User manual ver 1.0

The “Found New Hardware Wizard” will start
only if the drivers for the VaDia has never
been installed on the PC. In other cases, the
drivers will install automatically

In the “Found New Hardware Wizard” mark
the radio button “Yes, this time only” and
press “Next”

At this point the PC has to be connected to
internet

Select “Install the software automatically
(Recommended)”.
Press “Next”

Wait while the wizard searches the Windows
Update on the internet for the latest drivers.

The search may take some minutes, be
patient!

The drivers are finally found, and the
installation begins.

siiBioControl
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[Found New Hardware Wizard

The first driver is installed, press
Completing the Found New 1] =T ”
Hardware Wizard FInISh

The wizard has finished instaling the software for

E BioControl - BC Serial Convertsr 2010

Click Finish to close the wizard

Back Cance]

The installation of driver number two
starts immediately after finishing the
installation of the first driver.

i) Found New Hardware E
1I5E Serial Paork

- m
In the “Found New Hardware Wizard”
Welcome to the Found New

e B Hardware wizard mark the radio button “Yes, this time
Windows wil search for cunent and vpdated software by only" and preSS “Next”

looking on your computer, on the hardware instalation CD, or on
the Windows Lipdate b site [with your permission]
Read ou piivacy policy

Found New Hardware Wizard

Can Windows connect to Windows Update ta search for
softveare?

@ ez, i tme ol
© Yes, now and every time | connect a device:
© Mo, nat this time

Click Next to continue.

ook [ Hews | Cancel

Found New Hardware Wizard

There is no need for the CD.

Select “Install the software

T i o v sl o automatically (Recommended)”.
s Press “Next”

() If your hardware came with an installation CD
2 or floppy disk. insert it now

What do you want the wizard to do?

@ install the software

[
" Install from a list or spesific location (dvanced)

Click Mext to continue.

< Back | Mext > | Cancel
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Found New Hardware Wizard

Please wait while the wizard searches... .

@ USE Serial Port

Found New Hardware Wizard

Please wait while the wizard installs the software... .

(y BioConhiol - BC Serial Port 2010

) L/

ftseruiz.dil

e Cancel

Found New Hardware Wizard

Completing the Found New
Hardware Wizard

The wizard has finished instaling the software for

(g BioControl - BC Serial Port 2010

Click Finish to close the wizard.

L e

i) Found New Hardware E

Your new hardware is installed and ready to use,

= | ml
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Wait while the wizard searches the
Windows Update on the internet for the
latest drivers.

The search may take some minutes, be
patient!

The drivers are finally found, and the
installation begins.

The second driver is successfully
installed, press “Finish

This confirms that the installation of the
drivers is completed.

8/34 ziiBioControl
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3.4. Problems that may occur during driver installation
It might happen that this message pops up when installing the drivers. The PC
was not able to find the drivers.

i) Found New Hardware IE'

& problem occurred during hardware installation, Your new
hardware might not work, properly,

il ols|ml mcl el =Ml

If this is the case, the drivers can be installed properly by starting the help
function “USB Fix” in the VaDia Manager. Start the VaDia Manager:

B iotontrol VaDia Manager AN x| In the VaDia Manager, select “Help-
Sekl Vi ix”
stup View | Help >USB Fix".

UISB List WaDia

= Irit

About rezpanding!

Start
|

" Blugtooth

|-1
& Madim vdS
€ MT2000

Status

[ Advanced

This window will open. It can run for
several minutes, be patient!

When the window closes, unplug
and then plug the USB cable to
activate the drivers.
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3.5. Select aunique ID
To setup the VaDia, connect it to a PC trough USB and start the VaDia Manager
at “Start->All programs->BioControl->VaDia Manager”.

@ICCV? For AV ey

.

B_\ Motepad

S_- ‘ ti@ Elotec
SonicWwALL Glob =

= I Aubodesk:

BioControl SR Program Loader
Program Loader ver 1.04

-]‘j Microsaft Web Publishing Test Vadim 2

‘Wadim Program Loader 1,00

CRFL 2.03

i) ACaFile . Uninstall CRFI 2,03
GBCECUE, () vivotek Inc CRFI Staur
I ELMEC WaDiTine
= '@ b : A Lacation: <:\Program Files\BioCaontraliYabia
o start ]@ T 4T HI-TECH Software QUEE vaDia Manager ERED
x| If the connection is OK, the system
seiup dew Hiep parameters will be displayed on the
o YOI giatys field.
n O1-01-2000_D0:00:23
Start Battery: 1.47 W .
™ Blugtaoth 'I;drz‘;?‘.a:nD\l:eElsion: 1.01.010 ln the upper rlght corner the ID Of the
yacum 1: 0.0 present unit is shown. If required, the
f ] | [acum 300 ID can be changed by the user to any
acuum 4: 0.0 . .
. text of maximum 15 characters which
Vi o will then be used as the program ID,
- adim v
. the USB ID and the Bluetooth 1D
Status
[~ Advanced
B BioControl YaDia To change the ID, select
I—Setup Yiew Help Setup->VabDia Setup

iBioControl

Technology for biology
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BioControl ¥aDia Setup

Channel number  Text Streaming
¥abia  MTZ000 colors

N i —
W 3 —
N E—
20 i Co——

CHR. riumber: I ]

Bluetooth COM-port: COM119

W-axis Min: I -5 Max: | 50

1D: WD 1112-0006)

Cancel |
Ok |

BioControl ¥aDia Setup

Channel number  Text Streaming
Walia  MT2000 calors
N R T N .
e Bz N
N
+ [+ |4 N .

CHR rumber: ID
Eluekooth COM-port: I COoM119
Y-axis Mir: I*S Max: ISD

1D I B 1 Cancel |
Ok |
x
Setup View  Help
Box1
Init =
Sending |D
Stark oKl
™ Rhiatants
=

1 Disconnect and then reconnect the USE to activate the new Device ID!
L) Then close and restart the YaDia Manager!

T 2000

Status

[ Advanced
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Enter the desired ID, and press OK

After changing the ID, the VaDia USB
cable has to be cycled to make the
new ID valid.

Press OK to make the warning
disappear, and then close the VaDia.
Cycle the USB cable.

zBinControl
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jrj Found New Hardware

BioConkrol - BC Serial Conwerker 2010

mlclmel = m«

3.6. Make a Bluetooth connection
Before a Bluetooth connection is made, please set the VaDia ID as desired (see

3.5)

Start the VaDia Manager

Setup  Wiew Help

x|

Box 1

I 1032011 133636
Start | Battery: 1.09
N X Made: IDLE
i Program wergion: 1.01.001
acuum 1: 0.0
Wacuum 2 0.0
Wacuum 3: 0.0

&I acuum 4: 0.0
|-1

@ Vadim vd5
" MT 2000

Status |

™ Advanced

ﬂ BioControl ¥aDia Manager

Setup  Wew Help

Boxl

x|

il 1032011 134152
Start | Battery: 116
Mode: LOG BT

I Blugtooth Program wersion: 1.01.008
WYacuurn 1: 0.0
Wacuum 2: 0.0
WYacuum 3:-0.2
Wacuurn 4: 0.0

_1

& Yadim vdS
 MT2000

Status |

™ Advanced

April 2011 VaDia User manual ver 1.0

As the USB ID has changed, the Found
New Hardware message will appear.
As the driver already exists on the PC,
the drivers will install automatically.

Check the Bluetooth checkbox
Press Start to initialize the VaDia
Press Status to confirm that the
Bluetooth is active

Returned after pressing “Status”
Bluetooth started OK!

12134 z:BioControl
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WF ) FHLTUSUNL UL S

"’b\ AVR. Studio 4
K } Microsoft Excel 2010
@ ICCYT For AYR

@ Motepad
w Paint

!' Control

. Set Prol;re—“—-—‘J

Defaults | Provides options For

computer, add or re
e Connect T accounts,
=]

\é Printers and Faxes

All Programs  #

9) Help and Support
,_) Search

ERun...

Log Off @ Turn OFF Computer

workes  Tooks Help

Foldes | (-

Seediso 2

[q—
© rebwd s

Cou st
° Optians.

Pick a category

=
5, Appearance ant d Themes
[ Jemm— 1 Y
®

Y Y S——
o

@ (>

He

Qo -0 - 1]

ks [ s o0 trer o

See Also 2

Add aprinter

or pick a Control Panel icon

Troubleshooters B
(2) vrduere
B = =
[2) v o snatoffce
Hetworking G2 Game controlers &= Keyboard

) ouse
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B, Phone and odem op

2
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Start the Bluetooth service of the PC
from

“Start->All Programs->Control
Panel”

Select “Printers and Other
Hardware”

In the left border, select “Add a
Bluetooth device”




Add Bluetooth De: x|

Welcome to the Add Bluetooth
Device Wizard

Before procesding. rsfer to the "Blustooth” section of the
device documentation, Then set up vour device sa that pour
computer can find it

-Tumit on

-Make it dissaverable (visible]

- Give it & name (aptianal]
Fress the bultan on the bottom of the deviee
{keyboards and mice onl)

\j Add only Blustooth devices that you bust.

cga | Mets | Camd |

add Bluetooth Device x|

Select the Bluetaoth device that you want to add. GB®

@

i) IFyou donit see the device that pou want to add, make sure that it s
taneg o Fally e seup rsusions il cane wih e device. ooy i |
and then click Seaich Again Sz epin

Cancel

Add Bluetooth Device rd

=
Select the Bluetaoth device that you want to add. GB®

Jonathan
Already connected

i) IFyou donit see the device that pou want to add, make sure that it s
taneg o Fally e seup rsausions il cane il Ve ice.  geachagain |
and then click Seaich Again SRR

cgack [ Bets | Cancel |
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Check the check box “My device is set
up and ready to be found”
Press next

Wait while the PC is searching......

Select the Bluetooth device that you
want to add
Press next

BioContraol

Technology for biology



Add Bluetooth Device ard

Do you need a passkey to add your de

To answer this question, refer to the “Blustooth” section of the documentation that came with
your device, If the documentation specifies a passkey, use that one.

' Choose a passkey for me

ALN—

& Use the passkey found in the documentation:
" Let me choose my own passkey

' Don'tuse 3 passkey

75 You should dhvays use @ passkey, urless your device does not support one. Wa
tecommend using a passkey that is & to 16 digits long. The longer the passkey, the
mare sacure i wil be.

< Back I Next > I

Cancel |

Add Bluetooth Device Wizard

Windows is exchanging passkeys.

x|
®

When nstiusted below, enter the passkey using yaur Blustaath device.

For more information about entering  passkey, see the documentation that came with your
device

+ Connecting
+" Please enter the passkey on your Bluelooth device now,
Passkey 1111

* Installing Bluetooth device...

D

Cancel |

Add Bluetooth Device Wizard

® Completing the Add Bluetooth
Device Wizard

The Eluetosth device was suscesshuly connected ta your
Gomputer, ¥our computer and the device Gan communicats
whenever they are near sach ather.

These are the COM (serial] ports assigned to your device.
COM?1
CoMz2

Outgoing COM port
Incaming COM part

Learn more sbout

To close this wizard, click Finish,

|

|

Cancel

April 2011 VaDia User manual ver 1.0
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Enter the passkey “1111”

Wait while Bluetooth is installed

Write down the Outgoing COM-port
Press Finish

BioContraol

L]
Technology for biology




Kl Ready!

Devices | Optians | COM Perts | Hardwans | Return to the VaDia Manager

Phones and modems
Jonathan
Pazskey enabled

All other devices

Baox 1
Pazskey enabled

Bemave | Eroperties |

ok | Cancel | Appli |
x Goto Setup->VaDia Setup
Setup  Wiew Help
Box 1
it
11032011 13:45:31 g K
Start Batlery: 1.17 B BioControl YaDia
Mode: LOG BT
¥ Bluetooth \P;;ncgizm ;farus.lunn 1.01.008 SEtLIFI Wiew HElI:I

Wacuumn 2 0.0

Wacuurn 3 0.0
ﬂl W acuum 4: 0.0

7

' Wadim vd5
£ MT2000

™ Advanced
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BioControl ¥aDia Setup

Channel number  Text Skreaming
YaDia  MT2000 colors
LD o
e W
N aNE -
s BT m
CHR number: ID

Bluetooth COM-port: IW

‘f-axis I¥in: |-5 Ma: ISD

his]} IBox 1

Cancel |
Ok |

Change the COM-port setting into
the correct COM-port, in this case
COMT71, and press OK

At this point, the VaDia must be connected to a vacuum source to be able to
show data in streaming mode. If no vacuum is attached, the cursor will stay on

Zero.

ﬁ BioControl ¥aDia Manager

(123 FA S RIS

H

k] 1

Press View->Streaming Graph to

see the graph

April 2011 VaDia User manual ver 1.0
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4, Hardware
4.1. USB connector

The USB connector is located under
the rubber cap between the sensors.
Use the USB cable that was delivered
to make a connection between the
VaDia and a PC.

4.2. Battery

The delivered battery is rechargeable and has a capacity of 2500mAh. On a fully
charged battery, the device is able to log vacuum for 10 hours. It takes 5 hours to
charge a normally discharged battery (voltage 1.0V). As the charging is
electronically controlled, there is no need to unplug the USB when the charging is
complete. Leaving the USB connected means that the battery will maintained until
the next time to use the VaDia.

4.3. Charging the battery

Charging is performed trough the USB-cable, power is taken from the PC or a
USB charger. Charging of a normal discharged battery (1.0V) takes 5 to 10 hours.
As the charging is electronically controlled, there is no need to unplug the USB
when the charging is complete. Leaving the USB connected means that the
battery will be kept fully charged until the next time to use the VaDia..

4.4. Indicator LED
The LED gives information about the current status of the VaDia.

Status Function
Off Battery discharged
Red, short flash once per s Battery too low to start
Green, 4 flashes once per 15 s MODE is IDLE; VaDia not started yet
Green, 1 flash once per 15 s MODE is LOG or LOG BT; wait for vacuum
Green, 2 flash once per 15 s Same as previous; battery level low
Green, 3 flash once per 15 s Same as previous; battery level very low
Green, 1 flash per s MODE is LOG or LOG BT; vacuum present
Blue, 1 flash per s MODE is LOG BT; streaming mode active
Red, one flash once per 15 s Mode is STOP; Logs have been stored

While charging, the LED is yellow instead of green and violet instead of blue.

April 2011 VaDia User manual ver 1.0 18/34 ..EEEiDEDI’It-I"m
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5.  Operating the VaDia

5.1. Initializing a log session in normal mode

- Connect the battery

- Connect the VabDia to the PC trough USB

- Start the VaDia Manager

- If there is still data from a previous logging session stored in the memory,
save that log to a file first. When a new logging session is started, the old
data will be lost! Please see the chapter “Save a logging session” for how
to save a log.

Make sure that the Bluetooth checkbox

cotin View Hel is NOT checked when initializing a
& : logging in normal mode.

Fi———— Press “Start” to start a new logging
session. By doing so, the log memory is

&I deleted and the clock-calendar is set

™ Blustooth equal to the PC clock.

11032011 133514 Aftgr .the VaDia logging mode is.

Batteny: 116 initialized, press “Status” to confirm that
Mode: LOG the initialization was successful. The
Frogram wersion: 1.07.008 clock should be equal to the PC-clock,
VYacuum 1: 0.0 and the mode should be “LOG”. The
Egaam % DDD2 battery voltage should be 1.3 V or
Vacuumn 4: 0.0 higher.

In the case shown above, the battery voltage is too low. There will be a risk for
power loss during the milking session! Charge the battery first or replace it with a
fully charged one. NB! After replacing the battery, the VaDia will enter IDLE mode
and the clock setting will be lost. It must be initialized again to enter the LOG
mode.

As soon as the VabDia is initialized, disconnect the USB cable and close the USB
cap. Now the VabDia is ready for work!

5.2. Initializing a log session for streaming mode (Bluetooth mode)
- Connect the battery
- Connect the VaDia to the PC trough USB
- Start the VaDia Manager
- If there is still data from a previous logging session stored in the memory,

April 2011 VaDia User manual ver 1.0 19/34 ..EEEiDEDI’ItI"m
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save that log to a file first. When a new logging session is started, the old
data will be lost! Please see the chapter “Save a logging session” for how

to save a log.
Make sure that the Bluetooth checkbox
Setup View Help is checked when initializing a logging in
normal mode.

Press “Start” to start a new logging
session. By doing so, the log memory is
deleted and the clock-calendar is set
equal to the PC clock.

17012011 155827 After the VaDia logging mode is

Battery: 1.36 initialized, press “Status” to confirm that
Mode: LOG BT the initialization was successful. The
Pragram wersion: 1.01.004 clock should be equal to the PC-clock,
Wacuurn 1: 0.0 and the mode should be “LOG BT". The
ﬁggﬂam % SE battery voltage should be 1.3 V or
Wacuum 4: 0.1 higher.

It is presumed that the Bluetooth connection between the VaDia and the PC is
setup correctly. See xxxxx for how to setup the Bluetooth connectiuon properly.

As soon as the VabDia is initialized, disconnect the USB cable and close the USB
cap. Now the VabDia is ready for work!

5.3. In the field
First of all: Make sure that the VaDia is set into LOG-mode, see 5.1 or 5.2 for
details.

5.3.1 Secure the VaDia for leaks

Place the VaDia in such a way that no water
can enter the box trough the battery cover or
the USB cap. Use tape to secure the
openings, both the battery cover and the USB
cap. The VabDia is splash proof, but will not
withstand continuously being sprayed by water
and should not under any circumstances be
captured by water.

20134 siiBioControl

Technology for biology
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NB! The VaDia measures the vacuum in reference to
the air pressure in the test room. If the VaDia is
hermetic closed prior to the measurement, it is a
chance that the reference inside the enclosure may
differ from the air pressure in the room. Of that
reason, do not secure the VaDia for leaks until the
moment of using it.

A
5.3.2 Attach the VaDia to the test object

Attach the logger to the test object using PVC-tape.

Duct tape is used to attach and secure for leaks

. - . se0® o
April 2011 VaDia User manual ver 1.0 21/34 .zssnlucuntr‘ul
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5.3.3 Connecting the vacuum sensors

When the VabDia is attached to the test object,
the sensors must be connected to the vacuum
sources by a number of hoses. It is
recommended to use a 2 mm silicon hose as
the main hose, and a short 2x2.8 mm plastic
tube mm as described below.

NB! It is important that the tubes, hoses and
the VaDia itself are cleaned and disinfected
after use!

Use the pierce tool to find the correct length of
the stiff plastic tube. Use a side cutter to cutoff
the necessary piece of tube.

The tip of the tool should be free and the rest
of the steel string covered by the tube.

Find the test point and use the tool to make a
hole and pierce both the tool and the tube
through the hole.

. . XYY} '}
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The tool and the tube is pierced trough the teat
cup.

The tool is removed and the plastic tube is left in
the teat cup, ready to be attached to the silicone
hose.

Thread the silicon hose onto the plastic tube

April 2011 VaDia User manual ver 1.0 23/34 ..Esﬂiucnntrnl
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Ready for measurement!

5.4. Start logging
When the following points are completed, the logging can begin:
- Logging is initialized (5.1 Normal or 5.2 Bluetoth)
- Check that the logger is running and ready for logging which means that
the LED should flash green once per 15 seconds.
0 See chapter 4.4 for the different LED meanings
- Make sure that no water can enter the box (5.3.1)
- Attach the VaDia to the test object (5.3.2)
- Connect the vacuum sensors (5.3.3)
- Recheck that the logger is running and ready for logging: Green LED is
flashing once per 15 seconds.

For every 15 second, as the green LED flashes once, the VaDia measures the
vacuum to determine whether vacuum is present or not. If not, the device will
enter sleep mode to save the batteries. When the vacuum raise above 2,5 kPa,
the device will at the next 15 second interval, immediate leave sleep mode and
stay alert for at least 10 minutes. Once per second the LED will flash green (blue
in streaming mode) as long as the vacuum stays above 2,5 kPa.If the vacuum
disappears for more than 10 minutes, the VaDia will enter sleep mode and will
check the vacuum only once per 15 second.

5.5. Store the log to a file in the computer

When the log session is ended, the data has to be stored to a file on a computer
prior to be further managed. Connect the VaDia to a PC trough USB and start the
VaDia Manager.
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=l The information in the status field
sep tew e shows that the VaDia is connected. The
Box 1 . .
i mode can be in different states, the log
san || (b iy file can be stored regardless of the
" Bluetoath | |Fragam warson: .01.010 mode. If a log is present, do first select
yacam: 0.0 the log format: Vadim vd5 or MT2000.
vacuum 3 0.0 Then start the transfer of the logs by
o pressing “Get logs”
& Vadim vd5
© MT2000
Status |
[~ Advanced
Bovenes 2 A save dialog is opened. If this is the
e it [15 vabia H « @ first time when logs are stored,
s navigate to a folder where files of this
type should be stored, e.g. My
Documents. The next time to store
data, the VaDia Manager will remember
which location that was selected the
previous time.
Fie pame; = save |
Save as lype: [vaDia " vd5 | Cancel
2= When the folder is correct, type a
B Il filename in the filename field and click
“Save"
File name [Frs il | Save |
Save as lype [vaDia* vis =l Cancel
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Bl Biocontrol ¥aDia Manager

Setup  Yiew Help

x|

Box 1

it

Start |

[ Blustooth

& adim vd5
= MT2000

Statuz |

[T Advanced

Fiequest logs

ﬂ BioControl ¥aDia Manager

Setup Wiew Help

Box1

 Init

Start |

" Bluetooth

|-1
% Wadim vd3
 MT2000

Status |

" Advanced

Request logs

Transfer stopped nomally
‘wiiting logs to file, please wait
8 lags written

ﬂ BioControl ¥aDia Manager

Setup Wiew Help

Box1

 Init

Start |

" Bluetooth

|-1
% Wadim vd3
 MT2000

Status |

" Advanced

Request logs

Transfer stopped nomally

‘wiiting logs to file, please wait

Errar in log buffer, write to file sborted
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The transfer between the VaDia and the
computer will start, and a counter shows
that the transfer is running. The end
value of the counter depends on the
size of the logged data.

When all data is transferred from VaDia
to the computer, a text “Transfer
stopped normally” is shown.

Then the logs will be written to the file.
The text “Writing logs to file, please
wait” is shown while this happens. This
may take some time, please be patient!

As soon as the data is saved in the file,
the number of written logs is shown.

Should it happen that there are no logs
in the VaDia, the text “Error in log buffer,
write to file aborted” is shown.
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5.6. Work with the log files

To work with the log files, use the program VaDia Viewer for the vd5 files or
MT2000 for the mmd and mmt files. See the user manuals elsewhere.

5.7. Streaming mode

Through the Bluetooth connection it is possible to view the vacuum online on a

computer.

Only the first time of using Bluetooth:
- Select a unique ID as described in 3.5
- Setup the Bluetooth connection as described in 3.6

B sioControl ¥aDia Manager

Setup  View Help

x|

Box1

It

01-01-2000 00:00:15
Start | Battery: 1.36Y

Mode: IDLE

[~ Bluetooth Program vergion: 1.01.010
Wacuum 1: 0.0
Wacuum 2: 0.0
Wacuum 3: 0.0
2 | |Vacuum 4: 0.0
-1
£ %adim vd5
= pT2000
Status |
[~ Advanced

m BioControl ¥aDia Manager

Setup  VWiew Help

x|

Box1

— Imit -
Dreleting memory, please waitl
okl

[V Bluetaoth

Get logs |

:

7 Wadim vds
& MT2000

Status |

™ Advarced
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Normally:
Connect the VaDia to a PC trough USB
and start the VaDia Manager.

The information in the status field
shows that the VaDia is connected.

Check the Bluetooth checkbox and
click on “Start”.

In the status field, the text “Deleting
memory, please wait!” is shown

After a while, OK! is written which
means that the VaDia is ready for

logging.
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=l Click on “Status” to show that the mode is

e e e 6or | LOG BT which means that Bluetooth is
activated.

i 042011 _20:31:47
Start | Battenr 1.37 %
Mode: LOG BT
v Blugtooth Program version: 1.01.010

Wacuum 1: 0.0
Yacuum 2 0.0

Yacuum 3 0.1
ﬂl Wacuum 4 0.0

© Wadim vdS
& MT2000

:

E St

[~ Advanced

EifBioControl ¥abia Manager Next, click on View->Streaming Graph
Setup | Yiew Help

ning Graph

[ I RO B

f'”it || 0500207

The streaming graph will be shown. The LED of the VaDia will flash blue to show
that the Stream mode is activated over Bluetooth.

e =
O el
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1 _..6""'""-;'1_
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n | i f i |
. 1 | | | | |
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6. Configuration

6.1. Calibrate the vacuum sensors

The vacuum sensors of the VaDia were calibrated at the factory. Should it, of any
reason, be necessary to recalibrate the sensors then follow the instructions

below.

Connect the VaDia to a PC trough USB and start the VaDia Manager.

m BioControl ¥aDia Manager ﬂ

Setup  Wiew Help
Box1

It

Start |

[ Bluetaoth

01-01-2000 00:00:1%
Batterny: 1.36%

Mode: IDLE

Program version: 1.01.010
Wacuum 1: 0.0

Wacuum 2: 0.0

Wacuum 3 0.0

Wacuum 4: 0.0

1
& Wadim vds
 MT2000

Status

d

[ Advanced

m BioControl ¥aDia Manager x|

Setup  View Help

Box 1

= Init

06-04-2011 19:43:03
Start | Battery: 1.48Y
Mode: LOG
" Bluetooth Program version: 1.01.010
Wacuurn 1: 0.0
Wacuumn 2 0.0
Wacuun 3 0.1
ﬂl Wacuum 4: 0.1
a—
" Wadim vd5
& pTZ000
Statuz |
N - Calbrate sensars - 0kPa _* | 1] 2] 3] 4]
=2 0kPa - | 1] 2] 3] 4]
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The information in the status field
shows that the VaDia is connected.

Check the “Advanced” checkbox

The calibration buttons appears

The two leftmost buttons have a *
character instead of a number. These
two buttons are used when calibrating
all the sensors simultaneously.

Make sure that the pressure/vacuum
is stable zero for all sensors

Click the *button next to “OkPa”

Wait one second while the VaDia
calculates

After the calibration is done, OK! Will
appear in the status area

iBioControl
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Xl After the calibration is done, OK! Will

Setup  Miew
it appear in the status field

Tara all zensors
Stark | ak!

[T Blustocth

Get lags Click the “Status” button to see the
|.1— vacuum of the sensors after the zero

_ calibration.
% \adim vd5

 MT2000

Status |
Calitrate sensars 0 kPa [A]

23]
v Advanced 40kPa = | 1] 2] 3] 4]

m BioControl ¥aDia Manager ﬂ

. . All four sensors do now show a
etup  Yiew Help

vacuum of 0 as expected.

It

06-04-2011 19:46:59
Start Battery: 1.38%
Mode: LOG

‘

" Bluetaoth Program wergion: 1.01.010
Wacuum 1: 0.0
Wacuum 2: 0.0
Wacuum 3 0.0
Wacuum 4: 0.0
Sensorl tara: -9
Senzor] calib: 768
Sensor? tara: 0
= Yadim vdS Sensor? calib: 773
Sensord tara: -4
& MT2000 Sensord calib: 772
Senzord tara: 12
Sensord calib: 761

Get logz

|

Calibrate sensors 0kPa = | 1| 2| 3| 4|
e L [T

The next thing is to calibrate the sensors using a known value. The VaDia
calibration system requires a vacuum of 40 kPa on each sensor to perform the
calibration. Connect the necessary equipment (hoses and vacuum pump) to keep
the vacuum at a level of exactly 40 kPa.
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ﬂ BioControl ¥aDia Manager ﬂ

Calibrate all sensors simultaneously

Setup  Wiew
[ 2801-2011 161429 .
__ st | Batary: 133 Make sure that the vacuum is stable
I Blutooth | |Progra jor: 1.01.006
ki e 1TS0D 40.0 kPa for all sensors

“acuum 2: 40.0

Get logs | Eacuum 3: igg
Sensorl tors 3 Click the *button next to “40kPa”
Senzor] calib: 761

Senzord tara: 0
& Yadim vd5 Sensor? calib: 772

1

5 Jtara 0 i H H
O oo | [generdtaa Wait one second while the VaDia
Senzord tara: -13 Ca|CU|ateS

Senzord calib: 755

d Calibrate sensors 0kPa_+ | 1] 2 3| 4| | After the calibration is done, OK! Will
ke 2] 1121314 appear in the status area

To calibrate the sensors one by one:
- Make sure that the vacuum is stable 40.0 kPa for the sensor to calibrate
- Click the number button next to “40kPa” that corresponds to the actual
sensor
- Wait one second while the VaDia calculates
- After the calibration is done, OK! Will appear in the status area

6.2. Install the software VaDia Program Loader

The VaDia Program Loader installation program is found on the CD. Start the
program “Install VaDia Program Loader”, and the program will be installed on
your computer.

6.3. Load new firmware to the VaDia

Shut down any running instances of the VaDia Manager and connect the VaDia to
a USB port of the computer. Only one VaDia can be connected to the computer
when uploading new firmware.

Start the program “Install VaDia Program Loader”. The program is started using
Start->All programs->BioControl->VaDia Program Loader

X|| The first time the VaDia Program Loader is

executed, this warning might be shown.
Ireealid input: File!

Carcel |

Just press “OK” to continue

. . 000
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2 Set the device address is equal to

Intel hex file: 1

I [

— Communication port Target device—————————————————————
Start
UsE |

— Programming statu

File size: 0 byte

Device address
l1—

x| Press the Browse button next to
Intel hex fil: @ the Intel hex file text field

[l
r— Communication part Target device——————————
’V I Start

USE

i~ Programming statu

File size: 0 byte
Device address
i
open zi=ll  Browse for the VaDia hex-file, in
o e e this case “VADIM 1.00.005.hex”
E .l:ll:l‘l:\m.h»:-.-.
L Click “Open”
File name: [\ADIM 1.00.004 hex | Open |
Files of type: [ Intel hescie " he = Cancel
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i BioControl ¥aDia Program Loader

Intel hes file:
IE:\P|o|ects\BEplod\Vadlm\XMega\App\VelUT SRevl. 0044 ADIM 1.00.004. hex

— Cammunication port Target device———————————————————
Use [ |

i~ Programming statu:

File size: 262144 bute

Device address
|1—

m BioControl ¥aDia Program Loader

Intel hes file:
IC.\PIUiEClS\BCplud\Vadim\XMega\App\VelUW WRew01.004%ADIM 1.00.004.hex

r— Communication port Target device
use ’7 IXMega255 WADIZ

r— Programming statu:

Programming addiess BI532

File size: 262144 byte

Device address
|1—

m BioControl YaDia Program Loader

Intel hes file:
IE'\F‘rn\ecls\EEprnd\Vadim\}(Mega\App\\u"erD‘l “Fev1 0044401 1.00.004 hex

— Cammunication port Target devic
use ’7|><Megazss VADIZ

— Programming statu

Successl

File size: 262144 byte

Device address
1
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Press “Start” to load the new
firmware.

Information about the unit will be
shown, and a counter will
monitor the programming status.

When the programming address
reaches the listed File size, the
upload is finished.

When the programming is
finished, the text “success” is
written

Close the VaDia Program
Loader
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6.4. Technical data
Measuring frequency:

Accuracy:
Measurement range:
No of channels:

Communication:

Battery:
Weight:
Log transfer speed:

Casing:

Memory:

PC min. requirements:

April 2011 VaDia User manual ver 1.0

200 Hz pr. Channel

+-0,2kPa

0 to -80kPa

4

USB for setup and normal functions

Bluetooth Class 1 for Streaming mode, a maximum range
of 100 m can be obtained in a free visual line of sight and
good conditions. This requires that the Bluetooth module
in the PC is a 100 m version as well. The maximum range
is limited by the module with the shortest range.
Rechargeable or replaceable standard format AA

<80g with battery

25 s pr. hour of log

Splash proof, but care must be taken to minimize risk of
malfunction due to moisture inside the unit.

10 hours of logging.

Windows XP, Windows Vista, Windows 7
100 MB available hard disk space, 500 MB RAM, USB
communication port
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